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1. Introduction to Kernel for PowerPoint

Welcome to the user manual for Kernel for PowerPoint, the most effective and convenient .ppt, .pot and
.pps file repair tool available that repairs corrupt MS PowerPoint presentation files. This user manual
comprises step by step guidelines on using Kernel for PowerPoint.

1.1 Using this Manual

This user manual is intended to guide users on using Kernel for PowerPoint. We suggest that first time
users should read this user manual completely and carefully before proceeding to use the software.
However, if you are an experienced user, you can use the table of contents to find out information
pertaining to the tasks that you need to perform by using Kernel for PowerPoint.
You can use the table of contents to navigate through different sections of this user manual. The table of
contents lists all the sections that are contained in this user manual in chronological order. The user
manual comprises the following sections:

e Introduction

o Getting Started

e Software Interface

o Repairing .PPT files

e Full Version

e Support

e Troubleshooting

e Legal Notices

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual.

1.1.1 List of Abbreviations

PPT: PowerPoint

MS: Microsoft

RAM: Random Access Memory
MB: Mega-Byte

GB: Giga-Byte
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1.2 About Kernel for PowerPoint

Kernel for PowerPoint is file repair and data recovery software for MS PowerPoint presentation files. This
software repairs MS PowerPoint files that become inaccessible due to unexpected system shutdown,
power failure, virus attacks, media errors, bad sectors in the disk, software failure etc.

Kernel for PowerPoint provides effective recovery of the data which exists in the corrupt .ppt files. To do
so, Kernel for PowerPoint is incorporated with Standard mode of recovery which is built with powerful
recovery engine to repair the errors that occurs due to major corruption. This mode effectively recovers the
ppt file of big size with its content but in some cases, it recovers the images or objects in a raw format
which may needs to be organized again in the file. Other recovery mode includes Integrated mode, which
is fast and beneficial for the recovery of minor corruptions caused to your PPT file.

You might be familiar with the following error messages if you have encountered MS PowerPoint .ppt file
corruption before:

¢ Unable to read files.
e Thisfile is not in a recognizable format

o '?77?7.ppt cannot be accessed. The file may be read-only, or you may be trying to access a read-
only location. Or, the server on which the presentation is stored on may not be responding.

¢ POWERPOINT.exe has generated errors and will be closed by Windows. You will need to restart
the program. An error log is being created.

Kernel for PowerPoint quickly and effectively resolves the above mentioned errors by repairing corrupt
PowerPoint presentation files, keeping the complete document format intact. It restores deleted master
slides, images, objects, animations, tables, sound file, media player files, basic shapes, word art, banners,
callouts and all other components of the corrupt presentation file.

1.3 Salient Features

Salient features of Kernel for PowerPoint include:

o Efficient embedded repair algorithms to quickly repair even heavy files

e Support for almost all versions of MS PowerPoint

e User friendly graphical user interface

e No technical skills are required

e Live Preview of the recovered items of the repaired file before saving to new ppt files

e Supports .ppt,.pps.pot PowerPoint presentation file formats

e Equipped with two recovery modes: Standard and Integrated

e Live Update to update the older version of the software with the available latest version

Kernel |x3

©Nucleus Data Recovery.Com Private Limited for PowadPolnt



e Recovers data from password protected presentations if password is known to the user

o Free demo to test the capabilities of the tool before purchasing it

1.4 Who Should Use this Software?

The capability of Kernel for PowerPoint to repair large sized .ppt files makes it appropriate for use by
home users, college users, corporate users or any other user who keep their important presentation stored
in MS PowerPoint presentation files.

The software is also suitable for other MS PowerPoint users who have lost their important presentation

stored in password protected .ppt files due to .ppt file corruption. This corruption could have been caused
due to virus attacks, improper system shutdown, installation of unsupported software, etc.
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2. Getting Started

Now that you have understood the features and potential of Kernel for PowerPoint, you are ready to get
hands on experience of the software. To start repairing .ppt files, you will first need to download and install
this software.

It is strongly recommended that before installing Kernel for PowerPoint, you should go through the
installation pre-requisites for the software to ensure that your computer is appropriately configured to run
the software.

2.1 Installation Pre-requisites

The various pre-requisites for installing and running Kernel for PowerPoint can be broadly classified into
two major categories — Hardware requirements and Software requirements.

2.1.1 Hardware Requirements:

The hardware requirements for installing the software are as follows:
e Pentium Class Processor
e Minimum 64MB RAM (128 MB recommended)
e 10MB for Software installation

e Disk Space - Enough space to store the repaired files

. You should have at-least 10 MB of free disk space if you want to repair and save a
10 MB.ppt file.

2.1.2 Software Requirements:

The software requirements for installing the software can further be grouped into two categories —
Operating system requirements and MS PowerPoint version requirements. The requirements are as
follows:

2.1.2.1 Operating System Requirements
Supported operating systems:

e Windows Vista

e Windows XP

e Windows 2003

e Windows 2000
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2.1.2.2 MS PowerPoint Version Requirements
Supported PowerPoint versions:
e PowerPoint 2003

PowerPoint 2002

PowerPoint XP

PowerPoint 2000

e PowerPoint 97

2.2 Downloading Kernel for PowerPoint for the First Time

After checking your computer with the prescribed system requirements for Kernel for PowerPoint, you can
download and install the software on your computer. You can buy the full version of the software from any
one of our authorized resellers— Element5, Asknet and 2CO.

If you want to try using Kernel for PowerPoint before buying it, you can download the evaluation version
from the following link:

http://www.nucleustechnologies.com/Download-Powerpoint-Presentation-Repair-Software.php

X You can repair .ppt, .pps and .pot files saved on your system by using the evaluation
version of Kernel for PowerPoint; however, the repaired file will display the
recovered components of the repaired file but it does not allows to save the
recovered component until you purchase the full version of the software.

2.3 Install Kernel for PowerPoint

After downloading the installer file for Kernel for PowerPoint, you can install the software by running the
file. To install Kernel for PowerPoint:

1. Double-click the Kernel for PowerPoint installer. Follow the on-screen instructions.
The Setup Installation Complete screen will be displayed.

2. Click Finish to launch the software.

2.4 Start Kernel for PowerPoint

To start Kernel for PowerPoint:
Click the Start = All Programs >Kernel for PowerPoint

Alternatively, you can launch Kernel for PowerPoint by double-clicking the shortcut icon available on the
Desktop and Quick Launch icon.
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2.5 Uninstall Kernel for PowerPoint

You may need to uninstall and re-install Kernel for PowerPoint. To uninstall Kernel for PowerPoint:
1. Click the Start = All Programs >Kernel for PowerPoint - Uninstall Kernel for PowerPoint
A warning message will be displayed.

2. Click Yes to uninstall Kernel for PowerPoint.

W Before proceeding to uninstall Kernel for PowerPoint, you must ensure that the
software is not running.

You can alternatively uninstall Kernel for PowerPoint from the Control Panel by performing the following
steps:

1. Click the Start Menu = Control Panel and then double click the Add or Remove Programs icon.
2. Select Kernel for PowerPoint and click Remove.
A warning message will be displayed.

3. Click Yes to uninstall Kernel for PowerPoint.
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3. Software Interface

Now that Kernel for PowerPoint has been installed on your computer, you can start using the software
after getting acquainted with the software interface.

3.1 Menu-bar

The menu-bar of Kernel for PowerPoint comprises three main menus — File, Tools, and Help.

3.1.1 File Menu

The File menu comprises three menu items.

File | Tools  Help
1 add Fils
™ pecover

Exit

Figure 3.1: File Menu

Menu items in the File menu:

Add File Select to browse and list corrupt .ppt, .pps, .pot files stored on
your hard disk

Recover Select to start the process of repairing

Exit Select to close the software

3.1.2 Tools Menu

The Tools menu comprises two menu items.

Toals | Help

@ Live Update
%) Sekkings

Figure 3.2: Tools Menu

Menu Items in the Tools menu:

pm—
for PowerPoint
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Live Update Select to update the older version of the
software with the latest version available on
Nucleus server

Settings Select to specify the name of the folder(name
prefix) which contains the repaired files

3.1.3 Help Menu

The Help menu comprises two menu items.

Help ]

i.-7 about Mucleus Kernel PowerPoint recovery. ..

() Help

Figure 3.3: Help Menu

Menu items in the Help menu:

About Nucleus Kernel Select to view version-related and support information of
PowerPoint Recovery Kernel for PowerPoint
Help Select to view help information pertaining to performing

various tasks using Kernel for PowerPoint

3.2 Tool-bar

The tool-bar in Kernel for PowerPoint is displayed below the menu-bar. The tool-bar provides a convenient
and user-friendly method to perform certain actions that can also be performed by using the menu-bar.
Read the information in the table below to find out about the tool-bar buttons:

e Add File Select to browse and list corrupt .ppt files
Llj stored on your hard disk

Add Fil=

Kernel (53
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D

Recover

&)

Settings

€, =
Live Update

=
Buy Online

Recover

Settings

Live Update

Help

About

Buy Online

Select to start with the repair process

Select to specify the name of the folder (name
prefix) which will contain the repaired

presentation files

Select to update the older version of the
software with the latest version available on

Nucleus server

Select to view help files of the software

Select to view the version and other
information related to the software

Select to visit buy online webpage on our

website

3.3 Status Bar

Status bar is displayed at the bottom of the software window. The text ‘Ready’ is displayed on the status
bar if Kernel for PowerPoint is ready to be used. Status bar also displays the text ‘CAP’, ‘NUM’, ‘SCRL’
which respectively correspond to the Caps Lock, Num Lock, and Scroll Lock keys on your keyboard. If any

of these keys are pressed, the color of the corresponding text will turn blue/black.

I Ready

CAP NUM SCRL I

3.4 Buttons Used

Figure 3.4: Status Bar

Apart from the standard options available in the menu-bar and the tool-bar, two buttons— Browse, and
Recover are displayed on the main window.

©Nucleus Data Recovery.Com Private Limited
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Click to browse and select the .ppt(.pps,.pot) file that needs to be
repaired

Click to start with the repairing process
[> Recover

Click to stop the saving process in between

3.5 Customize User Interface

You can add or remove toolbar buttons by clicking:

T —>Standard in the toolbar and selecting appropriate buttons.
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4. Repairing .PPT Files

Now that you have complete familiarity of the user interface of Kernel for PowerPoint, you are ready to
repair .ppt files.

To repair .PPT files:

1. Launch Kernel for PowerPoint. Click the Browse button to browse and list corrupt PPT files.

COX

£\ Nucleus Kernel PowerPoint Recovery

i File Tools Help

s r @:--‘ o i e
m:;i RET 5.,995 mu;;_ H;lp)_ L;Jut qu;;jim L DATA RECOVERY
- \[m&m&-L POWERPOINT REPAIR
Pleaze select the file to repair
| |IBrnwse...I

fReady

Figure 4.1: Main Window- Kernel for PowerPoint
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Lok in: | () Powerpaint Files v o ®*rm

@Presentatiun 1 @Presentatiun 7
E,:]P'resentaticun £ E,:]P'resentaticun g
@Presentatiun 3 @Presentatiun E
@]Presentatiun "SI | Presentation 10
E,;]F'resentatin:nn a

@Presentatiun f

File name: |F'resentatiu:un 10 | I Open ]

[ Cancel ]

Files of type: | PawerPaoint Prezentations(*.ppt) w |

Figure 4.2: Select File for Recovery

2. Click Recover button to start with the .ppt file repairing process. After you click Recover, software asks
you to define the location to save the repaired file.

=16

£\ Nucleus Kernel PowerPoint Recovery

! File Tooks Help

oDy @ @
. AddFie Recover Seftings Livelpdaste Help  About BuyOnine DATA RECOVERY
L E = ) " DDOINT P
KERNEL POWERPOINTH REPAILR
Pleasze select the file to repair
|C:‘5Dm:urnent5 and SettingsihehalDeskiophF owerpoint Files\Fresentation 10.ppt | [Brnwse... I

@ Recover

UM

fReady

KERNEl@S
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Figure 4.3: Start Recovery
3. Browse to your desired location and click OK.

Kernel for PowerPoint displays the mode of recovery to repair the corrupt .ppt files: Standard mode or
Integrated mode

W Standard mode is powerful mode of recovery to handle major corruptions whereas
Integrated mode is faster mode of recovery to handle minor corruptions.

Recovery Mode Selection &l

Select Recovery Mode

{3 Standard Mode

This is the powerful mode of recovery. Use this mode to
recover Ffrom major corruptions.

() Integrated Mode

This is fast method of recovery, but it may Fail in some
cases.

] l [ Cancel

Figure 4.4: Select Recovery Mode
4. Select the appropriate mode and click OK to start with the repair process

As soon as Kernel for PowerPoint finishes the saving process, it displays the message“ Savi ng
Co mp | ewithealink that points to the location where the repaired file is saved.

. You can stop the saving of repaired files with the help of Stop button

5. Click the link to view the repaired files.

® The repaired .ppt files will be saved in the folder with the prefix defined by you in the
settings option.
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5. Full Version

Although you can use Kernel for PowerPoint evaluation version for free and experience the capabilities of
the software, there are certain features that are not available in the evaluation version.

5.1 Requirement of Full Version

By using the evaluation version of Kernel for PowerPoint, you can repair corrupt .ppt files; however, you
cannot save the recovered slides of the repaired files. You can only view the preview of the recovered
slides.

You will need to buy the full version of the software to save the recovered data of the repaired .ppt file

5.2 Purchasing Full Version

You can buy the full version of Kernel for PowerPoint from any one of our authorized resellers — Element5,
Asknet and 2CO.

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email
comprising the URL to download the full version of Kernel for PowerPoint and activation details of the
software.
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6. Support

We have an extensive and efficient support system in place to assist our customers with all issues related
to using Kernel for PowerPoint. The software comes with an embedded help manual that can be accessed
by clicking Help->Software Help in the menu-bar. You can also press the F1 key on the keyboard of your
computer to access the embedded help of Kernel for PowerPoint.

You can access the online help for Kernel for PowerPoint at
http://www.nucleustechnologies.com/Online-Helps.html

View Animated Working Demo of the software at
http://www.nucleustechnologies.com/powerpoint/animatedppt.html

We also have live support wherein you can chat with our software experts at
http://www.nucleustechnologies.com/Support.html

To talk on phone with our software experts call:

Help line:

+91-9818725861
1-866-348-7872 (Toll Free for USA/CANADA)
You can also email us about your queries at;

sales@nucleustechnologies.com for Sales

support@nucleustechnologies.com for Support

contact@nucleustechnologies.com for General Queries
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/. Troubleshooting

This section deals with your generic and specific queries pertaining to using Kernel for PowerPoint.

7.1 Common Issues

Why does Kernel for PowerPoint have limitations in evaluation copy?

The free evaluation version of Kernel for PowerPoint is intended to enable you to experience the
capabilities of the software. You will need to buy the software to save the recovered data.

7.2 Frequently Asked Questions

How to Buy Kernel for PowerPoint?

You can buy Kernel for PowerPoint online at http://www.nucleustechnologies.com/Buy-Powerpoint-
Presentation-Repair-Software.php

| have lost my full version for Kernel for PowerPoint. Can you help me?

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address,
and order confirmation number (if you have it). We will be happy to help you.

How long would | need to wait for the product after purchasing it?

The delivery of the product is immediate. You will be taken to download page after you complete the
purchasing process. The Activation Key and Password will be mailed to you with in next 15 minutes

When the recovery process is going on, an “ActiveX
message appears. How can | repair files?

This error message occurs due to incomplete installation of Kernel for PowerPoint software. If the
message ActiveX component cannot create an object is displayed then you should wait for a moment
and the Kernel for PowerPoint will automatically handle the error and proceed further.
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8. Legal Notices

This section comprises the legal specification about Kernel for PowerPoint and the company NUCLEUS
DATA RECOVERY.COM PRIVATE LIMITED

8.1 Copyright

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is
assumed, however, with respect to the use of the information contained herein.

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved.
8.2 Trademark

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and MS Office are
registered trademarks of Microsoft Corporation.

All other brand and product names are trademarks or registered trademarks of their respective companies.

8.3 Disclaimer

The Information contained in this manual, including but not limited to any product specifications, is subject
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty
with regard to this manual or any other information contained here in and here by expressly disclaims any
implied warranties of merchantability or fitness for any particular purpose with regard to any of the
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages
incurred directly or indirectly from any technical or typographical errors or omissions contained here in or
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or
any other information contained here in or the use there of.

8.4 License Agreement

Kernel for PowerPoint Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED
Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or distributing this
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of
each Licensed Copy of Kernel for PowerPoint. For purposes of this License, if you have a valid license,
you have the right to use a single Licensed Copy of Nucleus Kernel.

Kernel |x3

©Nucleus Data Recovery.Com Private Limited for PowadPolnt



Scope of License

Each Licensed Copy of Kernel for PowerPoint may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent,
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on,
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available
to others in connection with a service bureau, application service provider, or similar business, nor permit
anyone else to do so.

Warranty Disclaimers and Liability Limitations

Kernel for PowerPoint, and any and all accompanying software, files, data and materials, are distributed
and provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there
is no warranty for the quality of data recovered. You acknowledge that good data processing procedure
dictates that any program, including Nucleus Kernel, must be thoroughly tested with non-critical data
before there is any reliance on it, and you hereby assume the entire risk of all use of the copies of Nucleus
Kernel covered by this License. This disclaimer of warranty constitutes an essential part of this License. In
addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED authorize you or
anyone else to use Kernel for PowerPoint in applications or systems where Kernel for PowerPoint failure
to perform can reasonably be expected to result in a significant physical injury, or in loss of life. Any such
use is entirely at your own risk, and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED harmless from any and all claims or losses relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject matter, and
merges and supersedes all other or prior understandings, purchase orders, agreements and
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises,
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein.

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE
LIMITED of any other or future violation of the same provision, or any other provision, of this License.
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